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On the cover:  
Cytosolic sulfotransferase family of proteins was screened against a library of 90 

compounds by a thermodenaturation-based method (DSLS). Structures of cytosolic 

sulfotransferases are clustered according to their binding site structural similarity and 

surrounded by the molecules used in the binding experiments (Allali-Hassani et al., 2007, 

PLoS Biology. PMID: 17425406). 

 

Welcome to the workshop  
As part of the SGC’s ongoing program in structural genomics of human and malaria 

proteins we are also identifying small molecules that bind and stabilize our proteins, 

thereby promoting crystallization. We have implemented two screening platforms, based 

on either fluorimetry or static light scattering, to measure the increase in protein thermal 

stability upon binding of a ligand without the need to monitor enzyme activity (Vedadi et 

al (2006) PNAS. 103 (43):15835-40). Identification of small molecules that bind to 

proteins can provide valuable information on protein specificity, activity, as well as a 

practical means to facilitate 3D structure determination. This workshop aims to provide 

an opportunity for you to learn how to implement differential scanning fluorimetry (DSF) 

technique. We would like to take the opportunity to welcome you to our workshop.  
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How to prepare and run samples using the LightCycler 480 PCR 

system: 

  
 

Material needed: 
1) 96-well plate 

2) White, Roche 384-well PCR plate (Roche # 4729749001) 

3) Self-adhesive optical seal (these are provided with the Roche plates but BioRad 

sealing film, # 223-9444, may also be used) 

4) Protein sample(s) at 0.5 – 1.0 mg/ml concentration (for final concentrations of 

0.05 – 0.2 mg/ml . 

5) SYPRO orange stock solution (5000x in 100% DMSO) (BioRad #170-3120) 

6) Standard HEPES screening buffer (100 mM HEPES, 150 mM NaCl, pH 7.5) 

7) 96-well plate containing compounds at desired concentrations 

 

Determine the optimal protein concentration for screening: 

In order to determine if the protein is suitable to be screened using a fluorescence 

detection method and to determine the protein concentration that will yield reproducible 

data without saturating the fluorescence detector you should perform an experiment (pre-

screen) in which the protein is tested at three different concentrations: 0.2, 0.1 and 0.05 

mg/ml (due to the sensitivity of the LC480, it is possible that concentrations lower than 

0.05 mg/ml will work well). It may be necessary for you to measure the protein 

concentration (via A280 absorbance) to ensure the test is accurate. The procedure 

described below utilizes 20 l protein samples; however, good reproducibility was 

obtained with 10 l samples of a well-behaved proteins, so a smaller volume may work 

well and it may be useful to test this at the same time. 

 

1) Turn on the LC480 system and launch the LC480 control software from the 

desktop icon 

 

2) Prepare a 5x stock solution of Sypro Orange (the stock solution is 5000x in 

DMSO, the working concentration is 5x) in the standard HEPES screening buffer 

 

3) For each protein concentration to be tested, prepare a 50 l dilution at the desired 

concentration (e.g. 0.2, 0.1, 0.05 mg/ml) in the 5x Sypro Orange buffer solution 

prepared above  

 

4) If the preparation process requires an extended time or there is high ventilation 

there may be some evaporation of water from the samples. In this situation you 

can either keep the plate on ice to reduce evaporation or add extra water to the 

protein solutions to compensate for it. However, the latter may make it difficult to 

know the actual protein concentration in the test samples. 

 

5) Aliquot 20 l from each protein dilution into separate wells of a 384-well Roche 

PCR plate, seal the plate with optical sealing film, spin the plate for one minute at 
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1000 RPM and run the temperature scan experiment (described below). Note that 

it is not necessary to seal the entire plate with the film; a strip of sealing film that 

covers the wells in use is sufficient. 

 

6) Using either the curves displayed by the LC480 software or those generated after 

processing the data with Bafcon 6 , select an appropriate protein concentration for 

screening purposes based on the reproducibility of the data measured for the 

duplicate wells. Some proteins will produce very high initial fluorescence 

readings and will not be suitable for screening by the LC480.  

 

Sample preparation for screening: 
1) Turn on the LC480 and launch the LC480 software from the desktop icon. 

2) The routine for compound screening involves preparation of 1.11x compound 

solutions (in buffer) in a 96-well format to which a small volume of concentrated 

protein (with Sypro Orange) is added. For instance, 2.5 l of 9x protein / 45x 

Sypro Orange is added to 20 l of 1.11x compound solution to obtain 22.5 l of a 

1x solution of protein and compound. 

3) If you are screening the protein at 0.1 mg/ml (final concentration), prepare a stock 

solution consisting of 9x protein (0.9 mg/ml) and 45x Sypro Orange. If the results 

of the pre-screen experiment (above) indicate that a higher (or lower) protein 

concentration is required, prepare a solution containing 9x of that concentration of 

protein with the Sypro Orange still at 45x concentration. Prepare a volume of this 

solution sufficient for adding 2.5 l to each screening condition while taking into 

account volume loss due to pipetting errors and the additional volume required if 

using electronic repeating pipettors. 

4) Prepare 1.11x compound solutions at the desired concentrations. For a final 

concentration of 100 M compounds, prepare 111 M of each compound in the 

standard HEPES buffer and transfer 20 l of each into wells of a 96-well plate. 

5) Using a 12-channel pipette, aliquot 2.5 l of the protein / Sypro Orange solution 

(9x protein, 45x Sypro) into each well containing the compounds. 

6) Using a 12-channel pipette transfer 20 l from each well in the 96-well plate into 

the corresponding destination well in the 384-well LC480 PCR plate. Seal the 

plate with Roche optical sealing film (comes with the plates). 

7) Spin the PCR plate for 1 minute at 1000 RPM  

8) Proceed to the ‘Running a temperature scan experiment on the LC480’ section for 

running the screen. 

 

Running a temperature scan experiment on the LC480: 

The general procedure for running an experiment goes like this: start the LC480 software, 

load a pre-defined template that sets the range and rate of heating, place the plate into the 

instrument, click Start and enter a filename for the data. At the end of the experiment the 

Tm calling analysis routine is used to export the data in a tabular format for subsequent 

analysis. 

 

1) If not already powered on, turn on the LC480 system and launch the LC480 

software from the desktop icon. If the software is already running, it is a good 
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idea to close any open experiments before starting yours in order to ensure the 

software works properly. The lamp is automatically controlled by the system so 

there is no need to turn it on or off. 

 

2) After the software starts, the initial screen will appear as shown in this figure: 

 
 

3) Be sure to note the status icon in the bottom left corner (the triangle symbol) as 

well as the system message window adjacent to it to ensure the hardware is 

functioning properly. The LC480 software does not use conventional Microsoft 

symbols and buttons for accepting or cancelling settings. Instead, a check symbol 

() is used for “OK” and an X inside a circle () is used to cancel or close an 

object. 

 

4) Load the screening plate into the instrument. The LC480 instrument has three 

square buttons on the right side of the front panel. The two on the left are status 

displays that change color to show the instrument status while the one on the right 

is a button that opens and closes the sample tray. Push the button on the right and 

wait for the tray to eject, place your plate on the tray and push the button again to 

load the plate into the instrument. The instrument maintains the temperature of the 

plate at 30 °C so if your protein has a very low Tm it may be best to load the plate 

at the last minute rather than before the experiment has been setup. 
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5) Next, click the button labeled “New Experiment from Template”, located on the 

right-hand side of the window. This will open a window showing a list of 

available templates like this: 

 
 

6) Scroll to the bottom of the window where you will find the two templates (20-

75C_2.1sec-int_24sec-aq_20ul and 20-95C_2.1sec-int_24sec-aq_20ul) that have 

been prepared for routine screening experiments. The only difference between the 

two experiments is the temperature range they cover and the time required to 

complete. Select the template that encompasses the Tm of your protein and click 

the button with the  symbol. If you do not know the Tm (for instance, if this is a 

pre-screen experiment) then select the 20-95C experiment. This experiment will 

require about 76 minutes. 

 

7) If you do not have a template you need to write one as follow: from the main 

menu select  then-Detection Formats-New, name it Sypro orange, and select 

the combination filters ex 465 nm, em 580 nm from the filter selection panel on 

the right and close. Next, click the button labeled “New Experiment” go to the run 

protocol tab, select Sypro Orange, in analysis mode select melting curves. In the 

“temperature targets section” select target 20, acquisition mode none, hold 

00:00:01, ramp rate 4.8. Add another line using the + icon on the left and select 

target 95, acquisition mode continuous, acquisition 6 for 4
o
C/min or 24 for 

1
o
C/min heating rates. Save this as a template using the icon on the bottom left to 

use in future experiments.  
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8) After loading the template, the LC480 software window will look like this: 

 
 

9) The button labeled ‘Start Run’, located on the bottom right-hand side will only be 

available if a plate has been loaded into the instrument. Also, note that the 

estimated time shown below the Overview graph is not correct due to a software 

bug. Click the ‘Start Run’ button. This will open a file save dialog as shown in the 

next figure.  
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Note that the LC480 does not store experimental data as files but rather as entries 

in a database and that the directory tree shown above exists in the database, not on 

the file system. 

 

10) Navigate to the appropriate folder under the Experiments section and then enter a 

name for your experiment and click the check button. If you want to create a new 

directory for the data, this needs to be performed before starting an experiment. 

The experiment will start after this button is clicked and the screen will switch to 

the Data tab view:  
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11) In this view, the fluorescence signal from each well is displayed in the upper right 

plot and the temperature history is shown in the lower right plot. The progress of 

the experiment is shown in the upper left-hand side above the “Running 1 

program(s)” text.  

 

Exporting the temperature scan data to a tab-delimited text file for analysis: 

 

1) When the experiment is complete, the instrument’s run progress indicator will 

display “Run completed”. To extract the data in a tabular format, click on the 

button labeled “Analysis” that is found on the left-hand side of the window. This 

will start the ‘Create New Analysis” dialog: 

  
 

2) Select “Tm Calling” from the bottom of the list, which will open a window like 

this: 
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3) Click the  button to open an analysis of the data for all wells, which will bring 

you to a window like this: 

 
 

4) To export the data, right click in an empty area of the fluorescence plot shown in 

the upper right-hand side and select the “Export Chart” item from the pop-up 

menu. This will bring up a dialog for entering a filename and selecting how the 

data should be exported, like this:  
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5) Switch to the tab labeled “Data” and then enter a filename for the exported data in 

the space provided. It is not necessary to change any of the options in this dialog. 

You should set the location where the file will be stored by clicking on the box 

with three dots in it that is just to the right of the space where you entered the file 

name. A directory for holding exported data is located on the Desktop of the 

computer system and you can simply create your own subdirectory there for your 

data. 

 

Converting the exported data so that it can be used with Excel: 
Before the exported LightCycler data can be analyzed using Excel fit, it must first be 

converted to a compatible format. This is accomplished using a software program named 

Bafcon 6, which was written by Andy Wong of the SGC engineering group.  

Using Bafcon 6 is straightforward. After launching the program you will see a screen like 

this: 

 

 
 

1) To specify the input file for conversion, use the browse button to the right of the 

“Input File” box to locate your file 
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2)  For the “Output Directory” navigate to the folder that will hold the converted 

data 

3) For the “Output File Prefix”, enter the text you want to use for the converted 

intensities (this name will also be used to create a folder for the converted 

intensities) 

4) Select the output preference BioActive or Excel for Excelfit 

5) The “Resolution (°C)” drop-down menu provides the ability to set the resolution 

of the converted data (0.1 = 10 measurements / °C, 0.5 = 2 measurements / °C, 

and 1.0 = 1 measurement / °C). Depending on the settings for the experiment, the 

LightCycler instrument can collect tens or hundreds of points for each degree of 

heating, which is much more than is necessary for accurate curve fitting. 

Consequently, Bafcon 6 is also used to reduce the number of data points per 

degree to a more manageable number. A resolution setting of 1.0 provides 

sufficient resolution for analysis of the unfolding curves. 

6) After filling in the boxes and setting the resolution to the desired value click the 

green-shaded button labeled “Go”. The resulting converted data files can be found 

in the directory you specified. 
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How to prepare and run samples in the FluoDia T70 
 

Material needed: 

1) 96-well plates 

2) 384-well plates  

(Hard-Shell PCR plates: BioRad, catalogue number HSP3801) 

3) Protein sample(s) at 10x the final concentration (e.g. 20 µM if the final 

concentration is 2 µM)  

4) SYPRO orange   

(SYPRO orange: Invitrogen, catalogue number 56650)  

5) HEPES screening buffer (100 mM HEPES, 150 mM NaCl, pH 7.5) 

6) 96-deep-well plate (if needed) containing compounds at desired concentrations  

7) mineral oil (Sigma, catalogue number M-1180) 

 

Instrument: 

FluoDia T70 is a filter-based high temperature fluorescence microplate reader 

manufactured by Photon Technology International  

(http://www.pti-nj.com/FluoDia_T70.htm). 

 

Pre-screen protein concentration assay: 

In order to determine if the protein is suitable for screening with the FluoDia and to select 

the protein concentration that will yield reproducible data you should perform an 

experiment (pre-screen) in which the protein is tested at three different concentrations: 2, 

5 and 10 µM. It may be necessary for you to measure the protein concentration again (via 

A280 absorbance) to ensure the test is as accurate as possible. 

 

1) Prepare a 275x stock solution of Sypro Orange (the stock solution is 5000x in 

DMSO) in the standard HEPES screening buffer. 

 

2) For each protein concentration (2, 5 and 10 µM), prepare 55 µl of solution in the 

standard HEPES buffer and then add 1 µl of the 275x Sypro Orange solution to 

each (Sypro Orange is used at 5x final concentration).  

 

3) Aliquot 25 µl from each test solution into separate wells of a 384-well FluoDia 

plate, layer 10 µl of oil on each well, spin the plate for one minute at 3000 RPM 

and run the temperature scan experiment. 

 

4) Using either the curves displayed by the FluoDia software or those generated after 

processing the data with BafFConv and BioActive (proprietary software), select 

an appropriate protein concentration to be used for screening purposes based on 

the reproducibility of the data measured for the duplicate wells. In some cases, the 

protein may have a high fluorescence background that makes it unsuitable for 

screening by FluoDia.  

 

 

  

http://www.pti-nj.com/FluoDia_T70.htm
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Sample preparation for screening: 

 

1) If you are screening the protein at 2 µM (final concentration), prepare a stock 

solution consisting of 10x protein (20 µM) and 50x Sypro Orange. If the results of 

the pre-screen experiment (above) indicate that a higher protein concentration is 

required, prepare a solution containing 10x of that concentration of protein. In all 

cases the Sypro Orange dye should be at 50x concentration in the protein stock 

solution. Prepare a volume of this solution sufficient for adding 6 µl to each 

screening condition while also taking into account pipetting errors. 

2) Prepare the compound solutions at desired concentrations. For 100 µM compound 

(final concentration), prepare 112 µM of each compound and transfer them into 

wells of a labeled 96-well plate. 

3) Label the rows of another 96-well plate with the corresponding destination row in 

the 384-well plate as well as with the name of the protein you are characterizing. 

4) Using a 12-channel pipette, aliquot 54 µl of each compound into the appropriate 

wells in the 96-well plate. 

5) Using a 12-channel pipette, aliquot 6 µl of the protein / Sypro Orange solution (20 

µM protein, 50x Sypro) into each well containing the compounds. 

6) Using a 12-channel pipette, mix the solution, and then transfer 25 µl from each 

well in the 96-well plate into the corresponding destination well in the 384-well 

plate. 

7) Layer 10 µl of mineral oil on each well in the 384-well plate using the 12-channel 

pipette 

8) Spin the plate for 1 minute at 3000 RPM  

9) Begin the FluoDia experiment 

 

Running FluoDia: 

 

1) Turn ON the power supply of the FluoDia instrument, start the FluDiaT70 

software, log in to the program using the appropriate username and password and 

let the system initialize. 

2) After system initialization, the program’s main screen will appear similar to the 

screenshot shown below: 
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This screen will show you the parameters of the previous experiment such as the set 

of filters used, the integration time, the number of cycles etc... 

 

3) To create or open your own protocol click on the Protocol tab and the following  

window will appear: 

 

   
 

 

4) Use the following settings for the temperature scan experiment: 

- Kinetic should be ON. Otherwise click the Plate parameter tab and select 

Temp. Stepping Mode and return to the protocol window 
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- Set measurement method to Single (one wavelength) 

- Set interval to 123 sec (measurement time for a full plate). This will be 

the waiting time between the start of two continuous cycles. 

- Set the integration time to 50 ms (exposure time for the PMT detector) 

- Set number of averages to one, since we want the PMT to collect data 

once for each measurement 

- Set attenuation to 1, because we want the measurement result = measured 

value (this can be changed if the measured data is too high) 

- Select the measurement direction (row)  

- Set delay time to 0.1 sec  

- Make sure that you are using the right set of filters (for SYPRO orange use 

the filter set 465nm-590nm for excitation and emission wavelength, 

respectively). 

 

5) Use the Add button to give the new protocol a name and save it by clicking the 

Save button after you have completed editing it. 

 

6) Click on Plate parameter item from the Parameter listing in order to enter sample 

information such as the name assigned to each well. All available positions in the 

microplate illustration should be filled in with a sample name (e.g. Unk). You 

may use any text you would like but there must be some present to ensure that all 

of the wells will be scanned since the number of wells selected for scanning 

affects the rate at which the FluoDia performs the temperature scan.  
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- Choose the plate type: MJ(384) HSP 

- You can label the wells as Blank, Standard (Std), Unknown (Unk) or 

control. You can also put your own label by writing something in the ID 

header or use Sample ID if you want. When finished, click Set to have 

your label set in each selected well.  

- If you process the data using BioActive (proprietary software), which plots 

and fits the data for all 384 wells in parallel, note that the resulting curves 

will be labeled according to the Excel map rather than with the names you 

provided in the FluoDia.  

 

7) For temperature stepping setup, select the Temp. Control parameter item from the 

Parameter listing. A screen similar to that shown below will appear:  
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8) This is where you may enter the temperature control parameters. Use the 

following values: 

- Set Start Temp. to 27 °C 

- Set Target Temp. and Final Temp. to 75 °C 

- Set Delta t1 to 3 °C so that the temp increase occurs over about 1 hr. 

- The Delta t2 parameter can be ignored since we do not measure the 

temperature decrement between two steps.  

- Ucycles and DCycles are set to 1 because we are doing only one 

measurement per experiment. 

- Wait time is set to 0. 

 

9) The FluoDia can mix the samples during the experiment if this option is 

configured in the Mixing parameters item from the Parameter listing. However, 

this option is not used for our routine screening. 

 

 

After all of the parameters have been entered properly, save them and go back to the 

measurement window (by clicking the Measurement tab) to start your run. Once the 

temperature reaches the start of the experiment (27 °C), the first fluorescence 

measurement scan will start. When the scan is finished the system will heat the plate until 

the target temperature is reached. If we choose the Delta t1 to be 3 °C, the next target 

temperature will be 30 °C (27 + 3). When the final temperature of 75 °C is reached, the 

experiment is finished and the software will prompt you to save your data. You can save 

the data and analyze your data using FluoDia software. However, you may have to 

analyze a subset of data points (wells) each time.  
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Save your file as a csv file so that it will be compatible with the BafFConv conversion 

software (proprietary software). After you have converted the data with BafFConv you 

can analyze all 384 data points in parallel using the BioActive program (proprietary 

software).  Converting, plotting and labeling the data for all 384 samples will take 5-10 

minutes. 

 

When the FluoDia has cooled down, exit the FluoDia software and turn off the 

instrument. 

 

Ordering information: 

 

 SYPRO orange: Invitrogen, catalogue number 56650 

 Hard-Shell PCR plates: BioRad, catalogue number HSP3801 
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How to prepare and run samples using the Mx3005P Q-PCR system 
 

Instrument: 

Mx3005P Q-PCR from Stratagene (www.stratagene.com) 

 

Material needed: 

1) 96-well plate with round or conical-bottom wells 

2) White, non-skirted, low-profile 96-well PCR plate 

3) Support for PCR plate – an empty rack from a 200 l pipet tip box works well 

4) Self-adhesive optical seal for PCR (BioRad, order-no. 223-9444) 

5) Protein sample(s) at 20 – 100 M concentration (for final concentrations of 2 – 10 

M)  

6) SYPRO orange stock solution (5000x) 

7) Standard HEPES screening buffer (100 mM HEPES, 150 mM NaCl, pH 7.5) 

8) 96-well plate containing compounds at desired concentrations  

 

Pre-screen protein concentration assay: 

In order to determine if the protein is suitable to be screened using a fluorescence 

detection method and to determine the protein concentration that will yield reproducible 

data you should perform an experiment (pre-screen) in which the protein is tested at three 

different concentrations: 2, 5 and 10 M. It may be necessary for you to measure the 

protein concentration (via A280 absorbance) to ensure the test is accurate. The procedure 

described below utilizes 20 l protein samples; however, well-behaved proteins provide 

high-quality data with only half this volume (10 l). It may be useful to test this at the 

same time. 

 

1) Turn on the Mx3005P, launch the MxPro software from the desktop icon, and turn 

on the lamp by clicking the lamp icon on the toolbar. The lamp requires 20 

minutes to warm up before the system may be used. 

 

2) Prepare a 200x stock solution of Sypro Orange (the stock solution is 5000x in 

DMSO) in the standard HEPES screening buffer. 

 

3) For each protein concentration (2, 5 and 10 M), prepare 40 l of solution in the 

standard HEPES buffer and then add 1 l of the 200x Sypro Orange solution to 

each (Sypro Orange is used at 5x final concentration).  

 

 

4) Aliquot 20 l from each test solution into separate wells of a 96-well PCR plate, 

seal the wells with the optical sealing film, spin the plate for one minute at 1000 

RPM and run the temperature scan experiment (described below). Note that it is 

not necessary to seal the entire plate with the film; a strip of sealing film that 

covers the wells in use is sufficient. 

 

http://www.stratagene.com/
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5) Using either the curves displayed by the MxPro software or those generated after 

processing the data with BafFConv and BioActive (proprietary Software), select 

an appropriate protein concentration for screening purposes based on the 

reproducibility of the data measured for the duplicate wells. Some proteins will 

produce high initial fluorescence readings and will not be suitable for screening 

by the Mx3005P or other fluorescence based methods.  

 

Sample preparation for screening: 

1) Turn on the Mx3005P, launch the MxPro software from the desktop icon, and turn 

on the lamp by clicking the lamp icon on the toolbar. The lamp requires 20 

minutes to warm up before the system may be used. 

2) If you are screening the protein at 2 M (final concentration), prepare a stock 

solution consisting of 10x protein (20 M) and 50x Sypro Orange. If the results of 

the pre-screen experiment (above) indicate that a higher protein concentration is 

required, prepare a solution containing 10x of that concentration of protein with 

the Sypro Orange still at 50x concentration. Prepare a volume of this solution 

sufficient for adding 4 l to each screening condition. 

3) Prepare the compound solutions at the desired concentrations. For a final 

concentration of 100 M compounds, prepare 112 M of each compound in 1.11x 

standard HEPES buffer and transfer them into wells of a labeled 96-well plate. 

4) Label the rows of another 96-well plate with the corresponding destination row in 

the 96-well PCR plate as well as with the name of the protein you are 

characterizing. 

5) Using a 12-channel pipette, aliquot 36 l of each compound into the appropriate 

wells in the 96-well plate. 

6) Using a 12-channel pipette, aliquot 4 l of the protein / Sypro Orange solution (20 

M protein, 50x Sypro) into each well containing the compounds. 

7) Using a 12-channel pipette, mix the solution, and then transfer 20 l from each 

well in the 96-well plate into the corresponding destination well in the 96-well 

PCR plate. 

8) Spin the plate for 1 minute at 1000 RPM  

9) Proceed to the ‘Running a temperature scan experiment on the Mx3005P’ section 

for running the screen. 

 

Running a temperature scan experiment on the Mx3005P: 

1) If not already powered on, turn on the Mx3005P, launch the MxPro software from 

the desktop icon, and turn on the lamp. The lamp requires 20 minutes to warm up 

before the system may be used.  

2) After the software starts, the main screen will appear as shown in the figure 

below. Click the ‘Cancel’ button and use the lamp icon in the toolbar to turn on 



Prepared by: Dr. Guillermo Senisterra and Irene Chau 

Reviewed by: Dr. Masoud Vedadi 

 

 23 

the lamp (if not already on). 

 
 

3) Open the lid of the Mx3005P, pull the handle towards you and lift it to release the 

plate. 

4) Remove the old plate and dispose into a chemical waste container. 

5) Put the new plate in on top of the loose-fitting plastic frame and close the lid. 

6) Select the ‘New experiment’ option from the ‘File’ menu. You will be prompted 

to select from several options in a small window similar to that shown in the 

figure above. Select the first option, ‘Quantitative PCR (Multiple Standards)’ and 

click ‘OK’. 

7) The new experiment starts within the ‘Setup’ area comprising two sheets, ‘Plate 

Setup’ and ‘Thermal Profile Setup’. Next, you need to import the temperature 

scanning protocol into the software in two steps –follow the directions below. 

8) Within the ‘Plate Setup’ sheet click on the ‘Import’ button located on the upper 

right side (see the following figure). Next, navigate to the folder named 

‘protocols’ located on the Desktop and select the method you want to run. If you 

are unsure of the Tm of the protein being analyzed, select an experiment which 



Prepared by: Dr. Guillermo Senisterra and Irene Chau 

Reviewed by: Dr. Masoud Vedadi 

 

 24 

covers the largest temperature range.  
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9) After importing the experiment the screen should now appear like this: 

 
 

10) Next, click on the ‘Thermal Profile Setup’ tab or the ‘Next’ button located in the 

lower right corner and repeat the import process used above to load the thermal 

profile parameters into the new experiment.  
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11) After importing the parameters, the screen should appear like this: 

 
 

12) Click the ‘Start Run’ button located in the lower right corner of the software. This 

will open ‘Save As’ window as shown in the next figure.  
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13) Navigate to the ‘results’ folder located on the Desktop and then to the appropriate 

folder. 

 
 

14) Name the file in the standard manner and click ‘Save’. The experiment will start 

immediately after the ‘Save’ button is clicked. 

 

15) If the instrument will not be used again after this experiment or if you are running 

it as the last experiment of the day, check the ‘Turn lamp off at end of run’ box in 

the ‘Run Status’ window.  
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Exporting the temperature scan data to Excel for analysis: 

1) When the experiment is complete, the instrument will have switched to ‘Analysis’ 

mode and will display a window like this:  

 

 

       

 
 

2) Click on the ‘Results’ tab to switch to a view that shows the fluorescence plots. 

Within this section, change the displayed results from ‘dR’ to ‘R 

(Multicomponent View)’ using the drop-down menu in the right panel (circled in 
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red in the following figure). 

 
 

3) Click the ‘Select All’ button at the bottom of the right panel to ensure that data 

from all of the wells is being displayed.  

 

4) Next, export this data to Excel by following the ‘File’ menu listing in this manner: 

‘File -> Export Chart Data -> Export Chart Data to Excel -> Format2 – 

Horizontally Grouped Plot’. Exporting the data may take a minute or two, so be 

patient. 

 

5) An Excel window will appear showing a plot similar to that displayed in the 

previous figure along with the fluorescence data listed in tabular form. Use the 

‘File -> Save As’ menu item to save this data as an Excel file in the appropriate 

results folder. Be sure to switch to the ‘Microsoft Office Excel Workbook (*.xls)’ 

option from the ‘Save as type’ drop down menu located below the ‘File name’ 

box. It may be a good idea to give this file the same name as the MxPro filename 

used previously when starting the experiment (note that the Excel file will have a 

different extension so the MxPro file will not be overwritten). 

 

Alternatively, convert the Excel data into the format required by BioActive using the 

BafConf software (proprietary software) to analyze all 384 data points in parallel.  
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Ordering information: 

 SYPRO orange: Invitrogen, catalogue number 56650 

 Icycler optical PCR seal (pack of 100): BioRad, catalogue number 223-9444 

 White 96-well PCR plates may be obtained from a variety of sources (Stratagene, 

Axygen, Ultident, etc.) 
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How to import FluoDia data into Excel 
Purpose: 

Import data from a temperature scanning experiment into Excel so that it is in the proper 

format for use with the XLfit software. Excel cannot handle spreadsheets with more than 

256 columns of data. Since we are using 384-well plates to perform screening, the 

instruments generate data files with up to 384 columns of data (one per well). To get 

around the Excel column limitation, the data needs to be opened in two steps.  

 

Required Materials: 

1) Microsoft Excel 

2) A .txt formatted FluoDia data file 

 

Procedure: 

1) When setting up a protocol in the FluoDia T70 (see pages 6-12), the last step 

involves configuring the “Post Meas. & printer parameters” (see the figure 

below). To ensure your data is in the right format, be sure that your configuration 

looks like the one below in which the ‘Save file’ option is checked as well as the 

following options: for “Style” select both the “Plate view style” and the “Sheet 

view style” options, for “Format type” select the “Text (*.txt)” and “Excel 

(*.csv)” options, for “Delimiter”, select “Comma” from the drop-down menu list 

and for “Cycle” check the box for “All”. 
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2) The following steps assume you have run an experiment on the FluoDia and have 

a .txt formatted file containing the data from the experiment. We will use this file 

to get the data into Excel but it must be done in two steps due to the 256 column 

limit in Excel. 

 

Step one: importing data for wells A1 – K13 

1) In step one, the data for wells A1 – K13 is imported. The remaining data will be 

imported in step two (pages 27-29). 

 

2) Launch Excel, select the “Open” menu item from the “File” menu list. Be sure 

that the “Files of type” option shows “All Files”. If it does not, change it to that 

option. 

 

 
 

3) Find the .txt file saved by the FluoDia, select it and click “Open”. Excel will start 

the Text Import Wizard, showing this dialog:  
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4) Select ‘Delimited’ as the Original data type and click the Next button. 

 

 
 

5) In Step 2, select “Tab” and “Space” as the delimiters for the data and then click 

“Finish”. 
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6) After you click the “Finish” button, the following dialog will appear:  

 

 
 

7) Click “OK” and the data for wells A1 – K13 will now be visible in Excel. 

 

8) Next, change the name of the Worksheet by double-clicking on the Worksheet tab 

at the bottom of the program window. Enter some text that indicates this data is 

for wells A1 – K13 (such as protein_name_A1_K13): 

 

 
 

Step two: importing data for wells K14 – P24 

1) In step two, the data for wells K14 – P24 is imported. This is done by excluding 

the data for A1 – K13 using the Text Import Wizard. 

 

2) Repeat steps 2 – 5 in the “Step one” section above but do not click the “Finish” 

button. You should see a screen like this: 
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3) Use the vertical scrollbar (the one on the right hand side of the Import Wizard) to 

scroll down until you see the headings for the data in wells A1 – A3 (as in the 

view below). They should appear in separate columns separated by lines. 

 

4) Click the “Next” button to move ahead to Step 3. The window will now look like 

this: 
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5) Click once on the column labeled ‘A1’ in the Import Wizard window to select it. 

 

6) Using the horizontal scroll bar, navigate to the column labeled K13, hold down 

the Shift key on your keyboard and click once on the column labeled K13: 
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7) Next, select the ‘Do not import column (skip)’ option in the Column data format 

box of the Import Wizard window. Click the “Finish” button to import data from 

wells K14 – P24. No errors should be reported by Excel if everything worked 

correctly. 

 

8) Rename the Worksheet for the newly imported data in a similar way as you 

renamed the worksheet for the data from wells A1 – K13 (Such as 

protein_name_K14_P24 in the example below). 

 

 
 

9) Next, right-click on the Worksheet tab (where you just changed the name) and 

select the “Move or copy” menu item. You will see a dialog like this: 

 

 
 

10) Find the name of the Excel spreadsheet containing the data from wells A1 – K13 

in the “To book:” listing and select that file. Next, select the “(move to end)” 

option in the “Before sheet:” area and click the “OK” button. You will now have 

both sets of data in a single Excel file in a format suitable for use with XLfit.  
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How to analyze data using XLfit for Excel 
Purpose: 

The following SOP describes how to use the XLfit software to fit protein melting profiles 

measured using the PTI FluoDia T70 or a similar instrument (e.g. the Stratagene 

Mx3005P or GE Light Cycler RT-PCR machines). XLfit is a general purpose curve 

fitting package for Excel. The resulting curve fits will provide values for Tm as well as 

the slope of the unfolding transition. 

 

Required Materials: 

1) A copy of XLfit installed on your computer  

2) A properly formatted Excel file containing the temperature and corresponding 

fluorescence intensity values for each well  

 

Procedure: 

1. This SOP assumes that you have a properly formatted Excel file for use with 

XLfit. The data should be arranged such that there is one column listing the 

various temperatures at which a measurement was made followed by many 

columns of data (e.g. fluorescence intensities) measured at that particular 

temperature. Below is an example of the format: 

 

 
 

2. The following steps describe how to create a plot from your data and to fit the 

resulting curve. Once you have performed this step for one set of Temp. Vs. 

Intensity data the remaining data can be fit by simply copying and pasting the 

results from the first fit to the other columns of intensity data. 

 

3. Open the Excel file containing the data to be analyzed. The data in your file 

should be arranged similarly to that shown in the figure above. The results of the 

curve fitting will be stored in this Excel worksheet, below the cells containing the 

intensity data for each well. Before starting the fitting, add some labels to the cells 

underneath the column containing the temperature data so you will know the 

identity of the XLfit output that will be stored in the adjacent columns. Enter the 

following six items in individual cells below the list of temperature values: “min”, 

“max”, “Tm”, “dT”, “Fit Cell”, and “Chart Cell”,  so that your file looks like this 

(note that the arrow and colors are for illustration purposes only): 

Temp. A1 A2 A3

25 456827 356807 91835

33 442279 380437 102013

36 473497 409792 112456

38.9 492979 426869 119779

42 514560 450224 135374

45 569134 496670 158808

47.9 658207 576907 204193

50.9 820458 753240 298574

53.9 972145 906743 461780

57 1111997 1020921 670156

60 1142030 1063813 841760

62.9 1136005 1064179 931162

66 1077648 967707 983515

69 994377 891123 932224

72 969240 908621 935514

75 940729 867132 897072
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4. Next, open the XLfit “Fit Designer” tool by selecting it from the “Tools → 

XLfit4” menu item in Excel. The following window will open: 

 

 

 
 

5. Click in the box labeled “X Values” to make it active, and then select the X values 

from the column listing the temperatures by clicking on the first cell and dragging 

Temp. A1 A2 A3

25 456827 356807 91835

33 442279 380437 102013

36 473497 409792 112456

38.9 492979 426869 119779

42 514560 450224 135374

45 569134 496670 158808

47.9 658207 576907 204193

50.9 820458 753240 298574

53.9 972145 906743 461780

57 1111997 1020921 670156

60 1142030 1063813 841760

62.9 1136005 1064179 931162

66 1077648 967707 983515

69 994377 891123 932224

72 969240 908621 935514

75 940729 867132 897072

min

max

Tm

dT

Fit Cell

Chart Cell
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the mouse cursor to select all temperature values. You can include the header row 

in the selection, but do not select the cells containing the text you entered below 

the temperature values (in step 3). 

 

6. Click in the box labeled “Y Values” to make it active, and then select the Y values 

from the first column of measured fluorescence intensities. If you included the 

header row when you selected the temperature values, you should also select the 

header for the intensity data. 

 

7. Click on the box labeled ‘Fit Cell” (found below the plot) to make it active and 

then select the cell in the Excel worksheet adjacent to the cell you labeled “Fit 

Cell”. Repeat this step for the box labeled “Chart Cell” but select the cell adjacent 

to that labeled “Chart Cell” (just below the one you selected for the “Fit Cell”). 

 

8. If desired, you may also add Chart titles, and axis labels using the “Chart Details” 

section of XLfit (this is not required). The XLfit window should now show a plot 

of your data like this: 
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9. Next, fit the curve using the automated fitting feature of XLfit. Click on the tab 

labeled “Best Fit Search” and then click the “Start” button. XLfit will attempt to 

fit the curve using all possible models. To determine the model that best fits the 

curve, sort the results by the goodness of fit by clicking twice on the column 

labeled “r
2
” in the “Category” section of XLfit. The best model will have an r

2
 

value close to “1”. Click on the row corresponding to this model in the box 

labeled “Category” and information about this model will appear in the box 

labeled “Details”, just below the list of models. 

 

 
 

10. The best fit model should be the Boltzmann model (shown above with an r
2
 value 

of 0.99631 and shaded in gray). If it is not, there may be other processes affecting 

the thermal unfolding of your protein. If the Boltzmann model is in the second or 

lower position, but with reasonably good r
2
 value, select it from the list rather than 

another model. 

 

11. Next, click on the “Parameters” tab in XLfit to display the fitting parameters. The 

window should look like this: 
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12. In XLfit, the four fitting parameters for the Boltzmann model are named A, B, C, 

and D, corresponding to the minimum intensity, maximum intensity, Tm, and 

slope of the transition (dT), respectively. Assign a cell for each parameter similar 

to how you assigned cells for the “Fit Cell” and “Chart Cell” parameters (click in 

the “Output Cell” box for each parameter, and then select the destination cell in 

the Excel worksheet). The “A” parameter should be assigned to the cell adjacent 

to that labeled “min” in the Excel worksheet, “B” should be assigned to the cell 

adjacent to that labeled “max”, “C” should be assigned to the cell adjacent to that 

labeled “Tm”, and “D” should be assigned to the cell adjacent to that labeled 

“dT”. 

 

13. After you have assigned the parameters to the cells in the worksheet, click the 

“OK” button. The fitted parameters and the accompanying plot of the data from 

the first column should be visible in the Excel worksheet like this: 
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14. Analyzing and plotting the data for subsequent columns is relatively simple. First, 

it is necessary to make a couple of changes to the formula in the cell assigned to 

“Fit Cell” (the cell only displays the text “#Ok”). Click on the cell containing the 

“Fit Cell” formula. A formula will appear in the “fx” box of Excel, like this: 

 

 
 

15. Delete the “$” marks around the letter “B” at the end of the formula (the four “$” 

marks that are highlighted in green below. If your first column of data is in 

another position, the letter B will be replaced with the label for the column in 

Excel): 

 

 
 

16. The resulting formula should now look like this: 

Temp. A1 A2 A3

25 456827 356807 91835

33 442279 380437 102013

36 473497 409792 112456

38.9 492979 426869 119779

42 514560 450224 135374

45 569134 496670 158808

47.9 658207 576907 204193

50.9 820458 753240 298574

53.9 972145 906743 461780

57 1111997 1020921 670156

60 1142030 1063813 841760

62.9 1136005 1064179 931162

66 1077648 967707 983515

69 994377 891123 932224

72 969240 908621 935514

75 940729 867132 897072

min 474503.9

max 1053551

Tm 49.58576

dT 2.228427

Fit Cell #Ok

Chart Cell #Ok

25 40 55 70

450000

550000

650000

750000

850000

950000

+6
1.05x10

+6
1.15x10

=xf4_FitData("",xf4_SetModel("600"),xf4_SetParameters(0,FALSE,TRUE,100,FALSE,

TRUE,1,FALSE,TRUE,1,FALSE,TRUE),xf4_SetData(,$A$1:$A$17,,$B$1:$B$17)) 
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17. Next, select and copy the six cells containing the values for “max”, “min”, “Tm”, 

“dT”, “Fit Cell”, and “Chart Cell” and then paste them below the intensity data 

for any other columns of data you would like to fit. The cells assigned to “Chart 

Cell” will initially show the text “#NoObject” and none will have plots.  

 

18. To generate the plots and fitted data, it is necessary to ‘refresh’ the output from 

XLfit. To do this, select the “Refresh All” menu item from the “Tools → XLfit4” 

menu item in Excel. The text displayed in the “Chart Cell” should now read 

“#Ok” and plots should be visible for each column of data, like this (the three 

plots below are stacked upon each other): 

 

 
 

19. Data from future experiments can be analyzed in a rapid manner by simply using 

this file as a template into which you paste the new temperature and intensity data. 

=xf4_FitData("",xf4_SetModel("600"),xf4_SetParameters(0,FALSE,TRUE,100,FALSE,

TRUE,1,FALSE,TRUE,1,FALSE,TRUE),xf4_SetData(,$A$1:$A$17,,B1:B17)) 

Temp. A1 A2 A3

25 456827 356807 91835

33 442279 380437 102013

36 473497 409792 112456

38.9 492979 426869 119779

42 514560 450224 135374

45 569134 496670 158808

47.9 658207 576907 204193

50.9 820458 753240 298574

53.9 972145 906743 461780

57 1111997 1020921 670156

60 1142030 1063813 841760

62.9 1136005 1064179 931162

66 1077648 967707 983515

69 994377 891123 932224

72 969240 908621 935514

75 940729 867132 897072

min 474503.9 403530.4 114865.1

max 1053551 970156.2 948577.6

Tm 49.58576 49.50157 54.71538

dT 2.228427 2.150554 2.89428

Fit Cell #Ok #Ok #Ok

Chart Cell #Ok #Ok #Ok

25 40 55 70

450000

550000

650000

750000

850000

950000

+6
1.05x10

+6
1.15x10

25 40 55 70

350000

450000

550000

650000

750000

850000

950000

+6
1.05x10

25 40 55 70
50000

150000

250000

350000

450000

550000

650000

750000

850000

950000
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The plots and various fitted values will be updated with the new information after 

using the “Refresh All” tool. 
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